
خلق یک عکس کیهانی دستکاری شده در فتوشاپ

جزئیات آموزش
+Photoshop CS4 :نرم افزار

سطح آموزش: متوسط
زمان در نظر گرفته شده: 3 ساعت

در این آموزش ما نشان خواهیم داد که چگونه افکت ها و عکس ها را با هم ترکیب کنیم تا یک عکس کیهانی 
دستکاری شده در فتوشاپ ایجاد کنیم. 

موجودی آموزش

برای ساخت این آموزش از منابع زیر استفاده شده است.

- اشک ها
- فضا

مرحله 1 - ایجاد کردن ترکیب بندی اولیه

با ساختن یک سند جدید در فتوشاپ شروع می کنیم. اندازه های اولیه ما خیلی بزرگ است. برای این آموزش من 
اندازه اسنادم را به رزولوشن پایین تر تغییر داده یا به اندازه ایی که زمان ذخیره کردن آن به مشکل بر نخورم ) اندازه 

فایل 3000×2400، 50 درصد اندازه اصلی(.
 

هر چند، این برای من خیلی مهم است که با رزولوشن بالا کار کنم، تا در زمان انجام آن جزئیات بیشتری داشته 
باشم. همچنین من می خواهم که یک تصویر استوک خوب با هیجان بالا داشته باشم.

من برای این پروژه یک عکس استوک خوب خریدم چون باید آن را چاپ می کردم. برای یک مشتری خوب نباید از 
عکسی استفاده کنید که غیر قابل استفاده باشد. 
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به سندی که قرار است بر روی آن کار کنیم باز می گردم و پس زمینه آن را سیاه قرار می دهم. سپس عکس را بر 
روی سند قرار داده و اندازه آن را تغییر می دهم. در زمان تغییر اندازه تمرکز اصلی را بر روی احساس درون چشم 

های دختر قرار می دهم.
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حالا زمان آن رسیده که تصویر استوک بعدی را وارد کنم، اسم این عکس " یک نقطه در بین ستاره ها" است. این 
یک حرکت آشکار برای مرتبط کردن فضای پس زمینه است. من یک تصویر استوک با ستاره ها و ابری زیبا در آن 
را انتخاب کردم، اگر چه تنها از بعضی قسمت های کوچک تصویر استفاده کردم. بیشتر ستاره ها در تصویر نهایی با 

دست کشیده شده است.

تصویر را چرخانده و تغییر اندازه دادم تا در صفحه به درستی قرار گیرد. چون ما نمی خواهیم که آن زیاد از حد به 
چشم بیاید، آن را در ترکیب بندی خیلی تیره رنگ کردم. راه های زیادی وجود دارد تا بتوانیم یک تصویر استوک را 

تیره تر کنیم. من از Brightness/Contrast لایه با تنظیمات زیر استفاده کردم :

سپس لایه Brightness/Contrast را با لایه تصویر استوک merge می کنم، نتیجه merge شده را به زیر 
تصویر استوک انتقال می دهم.
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حالا یک لایه جدید بر روی لایه مدل ایجاد کرده، لایه مدل را پنهان می کنم. در این لایه می خواهیم یک قلموی 
بسیار بزرگ نرم برداشته و یک جریان ایجاد کنیم. من دو لکه و یک خط کشیدم که هر دو گوشه آن محو شده 

است. خطی که دو سمت آن محو شده را با ابزار pen کامل می کنیم. به سادگی در جایی که می خواهیم آن شروع 
و تمام شود کلیک می کنیم، سپس آن را با یک فشار کوچک می کشیم.
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لایه ای که حاوی مدل شما می باشد را Duplicate می کنیم. لایه استوک اصلی را به سمت پایین پالت لایه ها 
حرکت داده تا زمان کار مزاحم شما نباشد )ذخیره کردن یک کپی از تصویر استوک اصلی در زمانی که ممکن است 
بعدا به آن احتیاج پیدا کنید، به شما کمک می کند(. لایه دیگر مدل را به بالای لایه هایی که بر روی آن ها کار می 

کنید حرکت دهید. پالت لایه شما باید ظاهری مانند تصویر زیر داشته باشد:

حالا زمان آن رسیده که بر روی مدل کار کنیم. می خواهیم قسمت هایی از کنار صورت دختر را پاک کنیم. قسمت 
هایی از پوست را به حالت دست نخورده باقی می گذاریم. می توانید به وسیله لایه ماسک، ابزار eraser و یا ابزار 

pen آن را پاک کنید. این مهم نیست که از کدام یک از آن ها استفاده کنید و در این مرحله نیازی نیست که خیلی 
دقیق کار کنید. چیزهایی را که فکر می کنید مناسب نیست را به طور مبهم پاک کنید.

زمان آن رسیده که تمرکز بیشتری بر روی جریان اصلی در تصویر بگذاریم. در کار من گردش از بالا سمت چپ به 
پایین سمت راست کشیده می شود. من یک تصویر استوک از ابر های ساده باز کرده تا از آن به عنوان یک افکت 

استفاده کنم. ) من تنها قسمت بالایی تصویر را به کار می برم و نمی خواهم از قایق ها در تصویر استفاده کنم، 
بنابراین آن قسمت را برش می دهم(.
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حالا تصویر ما کوچکتر شده و باید آن را کمی تیره و سیاه و سفید کنیم. ابتدا یک لایه سیاه در بالای لایه استوک 
 multiply از سیاه به سفید با حالت gradient map ایجاد کرده و رنگ آن را تنظیم می کنیم. سپس از یک

برای تیره تر کردن آن استفاده می کنیم. با توجه به اینکه تصویر استوک اصلی شما چقدر تیره است، ممکن است 
لازم شود که gradient map را duplicate کنید.

 Edit > Transform > کرده و آن را به فایل تصویر بکشید. سپس از Merge در فایل استوک تمام لایه ها را
Warp استفاده می کنیم تا آن را به طور مناسب بر روی جریان کار قرار دهیم:
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تنظیمات این لایه را screen و opacity آن را 35درصد قرار می دهیم. گوشه های تیز آن را پاک می کنیم. حالا 
آن لایه را duplicate کرده و آن را 180 درجه می چرخانیم تا با سمت دیگر تصویر متناسب شود. حالا کار شما 
باید مانند تصویر زیر باشد. ) من لایه ابر را به خاطر لبه های تیزی که به علت استفاده از ابزار warp غیر عادی به 

نظر می آمدند، کمی بلور دادم(.

تصویر استوکی که استفاده کردیم را به یاد می آورید؟
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باید دوباره از آن استفاده کنیم تا افکت اصلی را بر روی مو های مدل ایجاد کنیم. )به این خاطر بود که ما مو های 
مدل را در مراحل اولیه پاک کردیم(. در این زمان ما تنها از قسمت مرکزی روشن استفاده می کنیم. تصویر استوک 

 duplicate را بر روی فایل تصویری قرار دهید و گوشه های تیز تصویر استوک را پاک کنید. حالا آن را 3-4 بار
کنید. من نمی توانم به طور خیلی دقیقی توضیح دهم که چگونه تصویر استوک را قرار دادم که دقیقا ظاهر مو های 
مدلم به این حالت شد، در اینجا شیوه آزمایش و خطا اهمیت دارد. شما باید کمی لایه هایتان را بچرخانید و با آن 

بازی کنید و در جایی که می خواهید مو ها پیدا باشند، قسمت هایی که فضای زیادی اشغال کرده اند را پاک کنید. 
در اینجا نتیجه نهایی را با 5 لایه مربوط به قسمت ستاره ها می بینید.

تمام این 5 لایه به حالت screen و با opacity به میزان 100درصد هستند. که یک چنین نتیجه ایی را داده است:

1 
له

رح
ی م

ه 
دام

ا

1 
له

رح
ی م

ه 
دام

ا



در پایان مرحله اول می خواهیم یک لایه جدید ایجاد کنیم، آن را با رنگ سیاه رنگ آمیزی کرده و تنظیمات آن را 
color قرار دهیم. در پایان این آموزش کل تصویر را به طور دستی رنگ آمیزی خواهیم کرد.

مرحله 2 - فضای ستاره و ضرب قلم های روشن

یک قلموی گرد سخت با تنظیماتی مانند تصویر پایین برمیداریم ) اندازه قلموی شما به اندازه بزرگی سند اصلی شما 
بستگی دارد، ما ستاره می کشیم بنابراین نباید زیاد از حد بزرگ باشد.(
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بر روی قسمت های مرکزی یعنی سر دختر با قلمو می کشیم، این تنها یک مرحله آزمایشی است. بعداً ستاره های 
بیشتری اضافه خواهیم کرد. لایه را به حالت overlay و opacity به میزان 45درصد تنظیم می کنیم.

حالا از یک براش استاندارد دیگر استفاده می کنم، یک قلموی نرم. در کل این آموزش ما تنها از قلموی سخت و 
 )soft brushe( برای ستاره ها و قلمو های نرم )Hard brushes( نرم استفاده خواهیم کرد. قلمو های سخت

برای خطوط روشنایی. برای کشیدن این خطوط من ار تبلت استفاده می کنم زیرا موس نمی تواند تفاوت های فشار 
و opacity را نشان دهد. اگر تبلت ندارید می توانید از ابزار pen استفاده کنید. در هنگام استفاده از تبلت از این 

تنظیمات استفاده کنید.
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با قلمو در جهتی یکسان مانند کار هایی که قبلًا انجام دادیم می کشیم. زیاد از حد بر آن فشار نیاورید، زیرا می 
خواهیم به ظاهری ملایم دست یابیم.

حالا لایه را به حالت overlay و با opacity به میزان +/ – 63درصد قرار می دهیم.
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پروسه طراحی خطوط ملایم را چند بار دیگر تکرار می کنیم؛ باید اندازه قلمو متنوع باشد! من این کار را دوبار و با 
قلموی کوچکتر تکرار کردم و به نتیجه زیر دست یافتم )هر دو لایه به حالت overlay قرار گرفته اند(.

2 
له

رح
ی م

ه 
دام

ا

2 
له

رح
ی م

ه 
دام

ا



همانطور که می بینید تصویر در حال حاضر بیشتر به حالت بافت دار در آمده است. برای اطلاع شما، این مرحله 
کامل "فضای ستاره و ضرب قلم های روشن" نامیده می شود، که بر اساس چند تکنیک ساده که با تکرار آن به 

نتیجه ایی درست دست میابید، می باشد. ما از تنظیمات قلموی یکسانس بارها و بارها استفاده می کنیم، ممکن 
است تعجب کنید که چگونه با لایه های کم چنین کاری را به سادگی انجام می دهیم. در این تکنیک لازم است که 
از آزمایش و خطا بارها استفاده کنیم؛ شما نمی توانید تنها با چند لایه همه چیز را درست انجام دهید. بنابراین می 

توانید این کار را بر روی چندین لایه انجام دهید تا هر کجا که خواستید بتوانید چیزی را اضافه و یا کم کنید.
حالا کمی بیشتر بر روی کل تصویر تمرکز می کنیم، تا اینجا تنها بر روی مرکز تصویر کار می کردیم. در مرحله 

بعدی در جاهایی که می خواهیم ضربه قلم های روشن بیشتری داشته باشیم، با یک قلموی نرم کمی بزرگ تر با 
opacity به اندازه 14درصد بر روی آن می کشیم.

یک لایه جدید ایجاد کرده و از آن خط های ملایم کمی بیشتر می کشیم. زمانی که می خواهیم میزان احساس 
نرمی را کاهش دهیم، این مرحله را تکرار می کنیم و هر بار این کار را با اندازه ای مختلف قلمو انجام می دهیم. 

)overlay دوباره با حالت(
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در این لحظه قسمت اصلی کار کمی خسته کننده به نظر می رسد زیرا تنوع بین روشنی ها و تاریکی ها کم است. 
برای ایجاد کنتراست و ایجاد تغییرات با استفاده از قلمو کمی سیاهی در اینجا و آنجا ایجاد می کنیم. این لایه را نیز 

به حالت overlay قرار می دهیم.

2 
له

رح
ی م

ه 
دام

ا

2 
له

رح
ی م

ه 
دام

ا



زمان آن رسیده که کمی ستاره به کار اضافه کنیم، از تنظیماتی مانند قبل استفاده می کنیم و دوباره از اندازه های 
متنوع و متفاوت استفاده می کنیم. این لایه ها به حالت overlay و 70درصد هستند.

در دو مرحله قبل ما با استفاده از نقاشی کردن رنگ سیاه در اینجا و آنجا کنتراست بیشتری ایجاد کردیم، من دوباره 
این کار را انجام می دهم چون هنوز از نتیجه کار راضی نیستم.
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همچنین در دو طرف کار به روشنایی بیشتری نیاز داریم، باید کمی از نقاطی را که قبلًا کشیدیم دوباره اینجا بکشیم. 
آنها را با قلموی نرم بزرگتری ایجاد می کنیم و تنظیمات آن را مانند قبل قرار می دهیم. لایه را به +/ – 43درصد 

تنظیم می کنیم.

دوباره قلمویی را که برای ستاره ها استفاده کردیم بر می داریم، آن را خیلی کوچک می کنیم، مال من 5px بود. به 
طور اتفاقی بر روی تمام قسمت های بومتان بکشید و با تفاوت ها و تنوع بسیار. همه چیز در طبیعت به طور اتفاقی 

است بنابراین بر روی یک قسمت از نقاط زیاد از حد تمرکز نکنید.
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هنوز مقدار جزئیات در ضرب قلم های روشن رضایت بخش نیست و همچنین به کنتراست بیشتری نیاز داریم. از 
قلموی نرمی با تنظیماتی مانند قبل استفاده کرده اما این بار خیلی کوچکتر از قبل. این دفعه به حالت اتفاقی نمی 
کشم و می خواهم حالت ترک در گوشه و کنار کار ایجاد کنم. اول با سیاه و بعد با سفید می کشم، می توانید این 

کار را بر روی یک لایه و یا چند لایه انجام دهید. لایه یا لایه ها را به حالت overlay قرار دهید.
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با یک قلم نرم بسیار بزرگ )مال من 800px بود و بدون تنظیمات( در قسمت هایی از کار که می خواهید روشن تر 
باشد به طور اتفاقی بکشید، حالت لایه را lighten و 14درصد قرار دهید. در ابتدا تغییرات زیادی به نظر نمی رسد 

اما زمانی که با قلمو های دیگر بر روی آن کار می کنید تفاوت های زیادی احساس خواهید کرد.

من مرحله ایی را که ستاره ها را بر روی بوممان اضافه می کردیم دوباره تکرار می کنم، بر روی یک لایه جدید و به 
طور اتفاقی می کشم. این بار قلموی من کمی بزرگ تر است اما تنظیمات آن را مانند قبل قرار می دهم. حالت لایه 

را Normal و 100درصد قرار می دهم، با این کار در روشنایی و اندازه تمام ستاره ها تنوع به وجود می آید.
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کار ما در مرحله دوم به پایان رسیده است. این تصویر نهایی برای این مرحله است )من کمی روشنایی بیشتر در 
اینجا و آنجا و با یک قلموی نرم کشیدم. این کار را قبلا توضیح دادیم و انجام آن بستگی دارد که آیا کار شما به آن 

احتیاج دارد یا خیر(.
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مرحله 3 - رنگ آمیزی و افکت ها

ابتدا با یک قلموی بزرگ نرم چند رنگ به طور اتفاقی می کشیم. این کار تنها کمی تنوع در رنگ در مرحله بعدی به 
وجود می آورد.

تنظیمات این لایه را color و opacity آن را 40درصد قرار می دهیم.
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حالا یک)...  photo – filter (Layer > New Adjustment Layer > Photo Filter با تنظیمات زیر 
اضافه می کنیم.

سپس تمام بوم را با یک رنگ زرد رنگ آمیزی می کنیم و تنظیمات آن را به Color و opacity آن را 20درصد 
قرار می دهیم.
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حالا زمانی را که کار را شروع کردیم و مدلمان را برش دادیم را به یاد می آورید؟ آن لایه را Duplicate کرده و آن 
را به بالای لایه ها بیاورید. تنظیمات این لایه را color و opacity آن را 50درصد قرار می دهیم.
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با یک قلموی نرم کوچک و چشمان دختر را کمی آبی می کنیم و تنظیمات آن را به overlay و opacity آن را 
75درصد قرار می دهیم.

حالا به قسمتی جالب می رسیم، من یک فایل A3 ایجاد کردم تا کمی افکت ستاره آماده کنم. چطور باید این کار را 
انجام دهیم؟ لایه پس زمینه را سیاه قرار می دهیم. حالا یک لایه جدید ساخته و سفید را رنگ اصلی خودتان قرار 

دهید. )U( را کلیک کرده تا ابزار ellipse انتخاب شود و یک شکل مانند این بکشید.
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سپس به Filter > Blur > Motion Blur بروید و این تنظیمات را اعمال کنید. ) ممکن است distance برای 
شما متفاوت باشد و به اندازه فایل شما بستگی دارد.(

لایه ایی را که بلور داده بودیم Duplicate کرده و آن را 90 درجه بچرخانید.
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لایه هایی را که حاوی شکل ها هستند را Merge می کنیم، آن را duplicate کرده و به اندازه 45 درجه می 
چرخانیم.

در اینجا شما باید 3 لایه داشته باشید: 1. پس زمینه سیاه 2. اولین مجموعه اشکال 3. دومین مجموعه اشکال. در 
لایه سوم Command/Ctrl – T را می زنیم تا آن را تغییر دهیم. در بالای صفحه تنظیمات زیر را وارد کنید.
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بعد از اینکه شکل اصلی ستاره ما ساخته شد، یک قلموی نرم برداشته و دقیقاً در مرکز شکل ساخته شده کمی 
درخشش ایجاد می کنیم.)Opacity این لایه را به 70درصد کاهش می دهیم(

تمام لایه ها را Merge کرده، به غیر از لایه پس زمینه سیاه. ستاره ها را تکثیر کرده و آن ها را در اندازه های 
مختلف ایجاد کنید.
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تمام ستاره ها را Merge کنید، در حال حاضر باید دو لایه در اسناد جداگانه داشته باشید. حالا می توانید با 
کشیدن لایه ستاره ها بر روی سند تصویری شروع کنید. در هر کجا که دوست دارید لایه ستاره ها را Copy و 

paste کنید، لایه را تغییر اندازه داده تا ظاهر بهتری پیدا کند. با انجام این کار در چند مرحله می توانید جزئیات 
ستاره ای بیشتری داشته باشید.

در همان ابتدای این آموزش ما از یک قلموی کوچک نرم استفاده کردیم تا خطوط ظریفی را بکشیم. حالا دوباره آن 
مرحله را تکرار کنید. زیرا من هنوز فکر می کنم که این خطوط چیندار کافی نیستند.
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آیا متوجه شدید که چطور در سند من این قسمت های تیره و روشن در محدوده مرکزی اصلی به وجود آمدند؟ ما 
از آن استفاده خواهیم کرد تا قسمت هایی را که رنگ ها قرار می گیرند را مشخص کنیم. من یک رنگ طلایی برای 
قسمت های روشن و یک رنگ قرمز برای قسمت های تیره انتخاب کردم. با یک قلموی نرم با اندازه متوسط شروع 
می کنم به اضافه کردن رنگ. سپس لایه ها را به حالت overlay قرار داده و با توجه به اینکه چقدر می خواهید 

رنگ شما پر رنگ باشد opacity آن را کاهش می دهیم.
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حالا از ستاره های جالبی که قبلًا ساختیم به کارمان اضافه می کنیم. شما همیشه می توانید دوباره از آن ها برای 
دیگر سند ها استفاده کنید )من به شما پیشنهاد می کنم که همیشه سند هایتان را ذخیره کنید تا بعداً هر زمانی که 

به آن ها احتیاج داشتید از آن ها استفاده کنید(. بنابراین به سادگی بر دور تا دور بومتان ستاره ها را اضافه کنید تا 
کارتان جزئیات بیشتری پیدا کند.

مرحله 4 - رسیدگی های آخر

حالا من یک gradient با تنظیمات زیر اضافه می کنم. )در preview مقدار opacity آن را 100درصد قرار داده 
و در تصویر آن را به 12درصد کاهش دادم(.
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که چنین نتیجه ایی را داده است:
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 Layer > New... به وسیله Brightness and Contrast برای ایجاد عمق بیشتر به کارم یک لایه
Adjustment Layer > Brightness/Contrast و با تنظیمات زیر اضافه کردم:

که چنین نتیجه ایی را داد:

Photo Filter .2 و  Hue/Saturation .1 :برای اصلاح بهتر رنگ ها دو چیز اضافه کردم
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که چنین نتیجه ای را داد:
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زمان آن رسیده که بر روی مدل اصلی تمرکز کنیم، با یک قلموی نرم کوچک )مانند تنظیمات قبل( بین سر و مو ها 
و با کشیدن رنگ سفید در جایی که آن ها از یکدیگر جدا شدند، کنتراست ایجاد می کنم.

با ابزار pen کمی مو برای تیره کردن آن می کشم. این کار را با یک قلموی سخت کوچک انجام می دهم.
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مرحله ایی که چشم ها را آبی درخشان کردیم را به یاد می آورید؟ دوباره آن مرحله را انجام می دهیم زیرا هنوز به 
آن روشنی دلخواه دست نیافته ایم. من همین کار را در مورد اشک ها نیز انجام می دهم و با آبی کردن آن ها، اشک 

ها بیشتر به چشم می آیند.
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کار ما تقریباً تمام شده است! تنها با کمی لایه ها را تنظیم می کنیم و کار ما به پایان می رسد!
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و بفرمایید!
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مرحله 5 )اختیاری( - تغییر دادن ترکیب بندی رنگی

این اولین باری است که من اینگونه کار می کنم، من اغلب زمانی که کاری را تمام می کنم دوباره بر روی آن کار 
نمی کنم. در هر حال من هنوز به طور کامل از ترکیب بندی رنگ ها راضی نیستم. بنابراین تصمیم گرفتم که یک 

Photo Filter و یک Hue/Saturation Filter اضافه کنم.
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نتیجه نهایی

تصویر را به طور افقی Flip کنید و حالا کار شما باید همانند تصویر زیر باشد.

یی
نها

یر 
صو

ت

مشاهده آموزش های دیگر سایت

www.persianGFX.com    منبع پرشین جی اف ایکس        

http://persiangfx.com/fa/tutorials/photoshop/photoshop-effects/


مجموعه پیش رو یکی از کامل ترین و برترین مجموعه های آموزشی در زمینه فتوشاپ می باشد که  ویژگی های 
خاص این مجموعه آن را از سایر مجموعه های مشابه متمایز نموده، از جمله این ویژگی ها قرار گیری هفت دوره 

آموزشی Adobe Photoshop CS4 ارائه شده توسط برترین اساتید جهان، به همراه مجموعه ای از نکات و 
ترفند های کار با فتوشاپ در قالب 101 پروژه آموزشی توسط آقای  Mark Monciardini مدرس مجموعه 
Photoshop Top Secret، همچنین مجموعه ی بی نظیر و نفیس Photoshop Top Secret با زبان و 

محیط 100درصد فارسی )با کمترین دستکاری(، در قالب 6 دی وی دی است، که در بسته بندی اختصاصی تقدیم 
شما می گردد.

محتویات این مجموعه بی نظیر به اجمال عبارتند از:
- مجموعه آموزشی Photoshop Top Secret به زبان فارسی با محیط کاملًا فارسی

Photo Tips 101 Mark›s مجموعه آموزشی -
- مجموعه هفت دوره آموزشی Adobe Photoshop CS4 شامل:

For Beginners Photoshop CS4 دوره آموزشی -  
Power Session Adobe Photoshop CS4 دوره آموزشی -  

Selections & Masks Adobe Photoshop CS4 دوره آموزشی -  
Mastering Layers in Photoshop CS4 دوره آموزشی -  
Design Effects With Photoshop CS4 دوره آموزشی -  
Beauty and Portrait Retouching Kit دوره آموزشی -  

Integration 4 Creative Suite دوره آموزشی -  

توضیحات بیشتر...

http://persiangfx.com/fa/other/products/persian-photoshop-top-secret/
http://persiangfx.com/fa/other/products/persian-photoshop-top-secret/


مجموعه فوق که در قالب دو دی وی دی آماده شده شامل مجموعه ای از ابزار و وسایل مورد نیاز طراحان و 
گرافیست ها و کاربران فتوشاپ است که شامل گلچینی از بهترین اکشن ها، براش ها، تصاویر پترن، شیپ ها، 

استایل ها و گرادینت است که همگی در قالب جعبه ابزاری گردآوری شده اند.
در این مجموعه سعی شده غیر از موارد فوق ابزار دیگری مانند بافت های بسیار زیبا، تصاویر اسلیمی شامل فریم 

های آماده بهمراه خوشنویسی های زیبا با فرمت وکتور و نیز مجموعه کاربردی از تصاویر لایه باز و کلیپ آرت، در 
کنار جعبه ابزار فتوشاپ قرار گیرد که در ادامه کلیه ابزار و محتویات به اختصار توضیح داده شده است

محتویات این بسته ی به اجمال عبارتند از:
Extended ME Adobe Photoshop CS5 نرم افزار -

- دوره مقدماتی آموزش فتوشاپ به زبان فارسی
CS5 دوره آموزشی لیندا آشنایی با پنج ابزار جدید طراحی در فتوشاپ -

Brush, Action, Pattern, Texture, Style , Shape جعبه ابزاری کم نظیر شامل منتخبی از زیبا ترین -
- مجموعه تصاویر زیبای لایه باز و کلیپ آرت های دوست داشتنی

EPS مجموعه تصاویر زیبای وکتور شامل فریم های آماده به همراه خوشنویسی های آماده زیبا با فرمت -
- مجموعه مجلات Photoshop Creative و دیگر مجلات گرافیکی

- مجموعه نادری از فونت های زیبای عربی
- مجموعه کلیه فونت های فارسی
- گلچینی از فونت های انگلیسی

توضیحات بیشتر...

http://persiangfx.com/fa/other/products/photoshop-professional-tools-box-02/
http://persiangfx.com/fa/other/products/photoshop-professional-tools-box-02/


مجموعه فوق شامل محبوب ترین نرم افزار های طراحی و گرافیک شرکت ادوبی بوده که ویژگی متمایز این 
مجموعه پشتیبانی نرم افزار های فوق از زبان فارسی است. که همگی تحت عنوان Standard Design یا نرم 
افزار های استاندارد شرکت ادوبی جهت انجام طراحی عرضه شده که نسخه اصلی Standard Design شامل 

نرم افزار های ادوبی به زبان انگلیسی بوده که در اینجا شما همان نرم افزار ها را با پشتیبانی از زبان فارسی 
دریافت می کنید، به همراه مجموعه فوق مجموعه فیلم های آموزشی شامل ویژگی های جدید این نرم افزار ها 
که توسط موسسه لیندا تهیه شده نیز وجود دارد. بسته فوق شامل دو دی وی دی بوده و در بسته بندی شکیل 

تقدیم به خریداران محترم سایت می شود.

محتویات این بسته ی به اجمال عبارتند از:
Extended ME Adobe Photoshop CS5 نرم افزار -

ME Adobe Illustrator CS5 نرم افزار -
ME Adobe InDesign CS5 نرم افزار -

ME Adobe DreamWeaver CS5 نرم افزار -
ME 9 Adobe Acrobat Pro نرم افزار -
- مجموعه فیلم های آموزشی Lynda شامل:

New Features Photoshop CS5 مجموعه آموزشی _  
New Features Illustrator CS5 مجموعه آموزشی _  
New Features InDesign CS5 مجموعه آموزشی _  

New Features Dreamweaver CS5 مجموعه آموزشی _  
- مجموعه نادری از فونت های زیبای عربی

- مجموعه کلیه فونت های فارسی
- گلچینی از فونت های انگلیسی

توضیحات بیشتر...

http://persiangfx.com/fa/other/products/adobe-crative-suite-5-standard-design-me/
http://persiangfx.com/fa/other/products/adobe-crative-suite-5-standard-design-me/


مشاهده سایر محصولات گرافیکی

کامل ترین مجموعه ابزار و ملزومات گرافیکی در قالب 13 پکیج مستقل مجموعا 35 دی وی دی

این پکیج شامل تمامی مطالب و موضوعاتی است که در طول سه سال گذشته بر روی سایت گذاشته شده و پس 
از جمع آوری و دسته بندی حرفه ای هم اکنون در اختیار دوست داران و علاقه مندان گرافیک و گرافیست ها قرار 

گرفته است که در ادامه به اختصار محتویات پکیج های فوق را می توانید مشاهده نمایید و اساسا این مجموعه 
شامل موارد فوق می باشد:

 
- بیش از 237 آموزش حرفه ای و مقدماتی نرم افزار فتوشاپ با فرمت پی دی اف به همراه تصاویر و فایل های 

ضمیمه
- بیش از 130 آموزش حرفه ای و مقدماتی نرم افزار ایلوستریتور با فرمت پی دی اف به همراه تصاویر و فایل های 

ضمیمه
- دوره کامل آموزش مقدماتی نرم افزار ایندیزاین بهمراه آموزش های دوره پیشرفته

- دوره کامل آموزش مقدماتی نرم افزار فلش به همراه آموزش های متفرقه
- بیش از 170 مقاله کاربردی با موضوعات مختلف و کاربردی گرافیک با فرمت پی دی اف

- ابزار طراحی شامل لوگو، آیکون، تصاویر وکتور، اسلیمی، کلیپ آرت و...
- تصاویر و آثار هنری هنرمندان و عکاسان جهت گرفتن ایده و افزایش مهارت های طراحی

توضیحات بیشتر....

http://persiangfx.com/fa/other/products/
http://persiangfx.com/fa/other/monthly/graphic-and-design-tools-monthly-archive/
http://persiangfx.com/fa/other/monthly/graphic-and-design-tools-monthly-archive/

